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Getting Started

Welcome to Switchvox, the world’s most powerful, yet easy to configure IP-PBX. This document describes
how to use the Web-based Switchvox User Tool Suite.

Throughout this document, we refer to the User Suite menu options as a path, using >’. Instead of saying
“select the Modify Account option from the Settings menu in the navigation bar, we say “select Settings >
Modify Account.”

IMPORTANT: You may find some features described in this document that are not available to you. This is
determined by the version of Switchvox you are using, and what features your Switchvox administrator has
given you permission to use. Please contact your administrator if you have any questions.

What is New in Version 4.57?

Version 4.5 offers great new features for your phone, additional profile information with a picture, and a
language setting.

Phone Feature Packs: Ringtones, Tools, and Display Options

The following features come with a Phone Feature Pack:

o

Upload Distinctive Ringtones to Switchvox
Use Ringtones and other options to identify different types of incoming calls
o Define several items on your phone's display

o Access Switchvox tools right from your phone
Directory, Voicemail Mailbox, Parking Lots, Phonebooks, and Record Call.

o

For details, see Phone Features.

Profiles

Justine Kilean

Account Manaoger

Extension: 101 0 2
Location: San Diego

An Extension Profile includes some or all of the following:
o Image
o First and Last Name
o Title
o Location
Extension Number

o



Profiles can be shown in the Switchboard and on a phone that uses a Phone Feature Pack. For details, see
Your Phone Feature Pack.

Language Setting

You can select a language preference for the User Suite, which will also set your Sound preference. For
details, see Language Setting.

About the User Suite

Each user has a Switchvox account that is his or her phone extension, and a password for that account. Ask
your Switchvox administrator for your extension number and password, and for the URL of your Switchvox
User Tool Suite (the User Suite).

Logging Into the User Suite

On a computer that is on the same network as Switchvox, open a Web browser and enter the URL of the User
Suite:

https://YourServerIPaddress/main

The Login page is displayed.

Please Log In To Use the Tool Suite

Extension |1 01 |

Password |-uu| |

Enter your extension and password (provided by your administrator). Once you are logged in, you may have to
change your password. If you do, the strength of your new password is indicated, to help you create a good
password. The next time you go to the User Suite, log in using your new password.

To log out of the User Suite, click Logout (located in the upper right-hand corner).

User Suite Navigation

The User Suite navigation bar contains the following dropdown menus:

Settings
Set up your account, specify how you want to handle calls, manage your Phonebooks, and set up your own
conference room.

Voicemail / Fax



Manage incoming and outgoing voicemail and faxes, set up voicemail greetings, and customize email
notifications for voicemail.

Call History
See logs of all calls to and from your extension and run usage reports.

Getting Help

Click any help link to open a pop-up window with information about a particular tool. Help links are available as
question-mark icons and as text links.

EI How do I use this page?

If a pop-up window does not display, set your Web browser to allow pop-ups from the domain of your
Switchvox server.



Settings

The Settings area is where you set up your account, specify how you want to handle calls, manage your
Phonebooks, and set up your own conference room.

Modify Account

This section lists basic information about your Switchvox account.

Your administrator may have given you permission to change this information. If you do make changes, click
Modify Extension to save those changes. The page is refreshed, and a message indicates that your changes
were successfully saved.

If you are changing your password, the strength of your new password is indicated as you type, to help you
create a good password. The next time you go to the User Suite, log in using your new password.

Your Profile

Justine Kilean

Account Manager

Extension: 101 2 2
Location: San Diego

An Extension Profile includes some or all of the following:

° Image

o First and Last Name
o Title

o Location

o Extension Number

Profiles can be shown in the Switchboard and on a phone that uses a Phone Feature Pack. For details, see
Your Phone Feature Pack.

Profile Picture
To add a picture:
1. Click Add an image.

2. Click Browse, and then find the image file on your computer.
Images must be at least 75x100 pixels, and must be in jpg format.

3. Click Upload.
The image is uploaded and displayed with the crop area that will be used to make a 75x100 image. You



4.
5.

can move the crop area around to choose the best portion of the picture. The Preview on the right shows
you what the picture will look like once it is cropped.

Click Save Image.

Click Save Extension Settings.

To upload a different picture, re-crop the existing picture, or delete the existing picture:

1.
2.

Click View Image.

Click ReCrop, or Delete.
If you want to upload a different image, Delete this image now, and then click Add an image to start
again.

. Confirm your changes.

. Click Save Extension Settings.

Language Setting

The Switchvox web-based tool suite is available in several languages:

== English for United States
&l3 English for United Kingdom
— Spanish for Spain

[:0 Spanish for Mexico

[ N ltalian

To set your preferred language:

1.
2.

Select a language from the dropdown.

Select a locale for that language.

If you choose to use a language other than English for US, there are some important issues to be aware of:

o Dates
All other languages and locales handle dates with the format of day, then month, then year (as opposed to
mm/dd/yyyy).

o Sound Packs

There are Sound Packs available for each Language preference. Once you select a language, Switchvox
serves you the sounds from that language's soundpack. For example, if you switch to the Italian
language, and then you call the voicemail access extension, the prompts will be in Italian. Soundpacks
must be installed by the Switchvox administrator (see the Admin Suite Digium Addon Products).

Call Rules

Call Rules control how your calls are handled. Here are some examples:

o When I'm on the phone, go straight to voicemail
o If I don’t answer, ‘cascade’ calls to my mobile phone then my home phone


../../../Content/d/Digium_Addon_Products.htm
../../../Content/d/Digium_Addon_Products.htm
../../../Content/d/Digium_Addon_Products.htm

o Forward all my calls to another extension
o On weekends and evenings, forward all my calls to another extension
o Hang up on calls from a certain phone humber

Settings Yoicemail £ Fax Zall History

Call Rules

I] call Rule Sets |7

Unanswered Call Rule Sets

Add Hew Rule Set

# Rule Set Information

Mame: Forward to my mobile Time Frame: Cutside Business Hours
1 1. cCascade direct calls to 216195551234 immediately and atternpt to preserve caller id.

2. Zend direct calls to woicemail after 4 rings.

Busy Call Rule Sets

_OR_
M uUse my unanswered call rule sets m

You currently do not have any rule sets defined in this section.

EI call Blocking |2/

Add Call Block Rule

# Move Unanswered Call Rule Sets

) @ Block [ Phore Number » | (818585551234 | and Then [ Send ta Vaicemal |

when time is |.-’-'-.Iwa_l,ls V|

E Messages/fPrompts

Secret Code  “Slease enter vour password followed by the pound Ley,

Secret Code  “FPassword incorrect, Flease ender vour password followed by the pound

"

kay,



Call Rule Sets

Unanswered Call Rule Sets specify how a call is handled after a certain number of rings. Busy Call Rule
Sets specify how a call is handled when your line is busy. You can set up different rules for those situations,
or use the same rules.

When a call is unanswered or your line is busy, Switchvox evaluates each of your Call Rules in the order
listed. The first set is evaluated in order, then the second set, and so on. That means that the ‘During
Business Hours’ rule that forwards a call to your mobile phone must come before the ‘Anytime’ rule that sends
a call straight to your voicemail.

It's a good idea to test your rules by calling your extension from another phone.

Creating a New Call Rule Set

To create a new Call Rule Set under Unanswered or Busy, click the appropriate New Rule Set button. To
create a new Busy Call Rule Set, you must first un-check the box Use my unanswered call rule sets. That
makes the Add New Busy Rule Set button active (it turns blue), so you can click it and create a new rule
set.

When the settings are correct, click on Save Ruleset Settings to create the new rule set and add its rules.
1. Select the type of rule to add from the dropdown

. Click Add Rule.

. Specify whether the rule applies to direct calls, queue calls, or all calls.

. Depending on the type of rule you are adding, enter the appropriate extensions or phone numbers.

. If you are adding a Secret Code rule, enter 1 to 10 digits.

o o0 B~ WDN

. If you are creating an Unanswered rule, specify the number of times to ring your phone before following
this rule.



[l Rule Set Rules ?!

[ Send Tooicemail ~ | [REET IS

# Mowe Call Rules

LD Cascade | drectcalls | to [916185551234 | after [ Immediately
Atternpt to preserve caller id.

2 @ Send | drect call: | % | to woicemail aﬂ:er

ﬂ Rule Set Settings

Rule Set Mame |F|:|rwar|:| to my m|:||:ui|e|

Example: ©&n Wacation

Rule Set Time Frame | Outside Business Hours |

Wwhen is this rule set used?

Modify Buleset Settings

Rule Set Name
Enter a unique name for this rule set.

Rule Set Time Frame

Select a time frame from the dropdown. Switchvox evaluates the current date and time against this time
frame, and if they match then the rule is followed. If they do not match, Switchvox moves on to the next rule.
See Time Frames for more information.

Send to Voicemail
This rule sends a call to your voicemail so the caller can leave a message.

Call Forward
This rule forwards a call to another Switchvox extension. The extension can be another phone, a call queue, or

any other type of extension. Once a call is forwarded to the extension, the call rules for that extension are
followed.

Call Cascade

This rule rings another extension or an external phone number (i.e., your mobile phone), and if the call isn’t
answered then it is passed on to the next rule in the set. This action depends on your Outgoing Call Provider,
but if your provider supports it, you can stack several rules that try and reach you at several phone numbers.
Note: If you are cascading a call to an external phone number, be sure to add a ‘9’ or other necessary digits
that you normally use to dial out.
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Secret Code

This rule prompts the caller to enter a secret code, then passes the caller to the next rule in the set. If the caller
cannot enter the correct secret code after the specified number of tries, then you can specify what to do with
the call.

Ring All
This rule simultaneously rings up to 3 extensions or external phone numbers. Nofte: If you are ringing an
external phone number, be sure to add a ‘9’ or other necessary digits that you normally use to dial out.

Managing Call Rule Sets

If you have multiple Rule Sets, you can drag and drop them to prioritize them appropriately, or you can delete
them and replace them with new rules. Your rules need to be put in order because they are executed from top
to bottom.

You can have different rule sets for different times, and activate or deactivate them as you see fit. In order to
activate a rule set, click on the Activate button to the right of the rule, and fill in the time you want the rule to
occur. The active rule set will be highlighted yellow and will display how long it will be active on the right side.
This process is the same for Unanswered or Busy Call Rule Sets.

Call Blocking

Switchvox lets you specify phone numbers that you do not want to accept calls from. You can block specific
phone numbers, or any numbers that begin with the same prefix, and you can block them at all times or during
specified time frames. You can also choose how Switchvox handles the blocked calls.

Click Add Call Block Rule and a new blank rule section appears. Select Phone Number or Prefix from the
dropdown, then enter the number. Be careful entering a prefix; if you put in the wrong prefix you might end up
blocking more calls than you expected. Select the action Switchvox should take with the blocked call, then
select a Time Frame if you want to control when these calls are blocked. Click Save to save your changes to
the Call Block Rule.

Messages/Prompts

If you use the Secret Code feature in a Call Rule, the default sound prompts are provided here. You can
change the prompts by recording your own sound over your phone, or uploading a new sound file.

To add or change your own sound, click the prompt’s New button. To play the sound, click the prompt’s Play
button. To remove a sound that you created, and go back to the default sound, click the prompt’s Use Default
button.

Time Frames

Switchvox can operate differently based on the date, day, and time. You can set up your Call Rules to check
fora Time Frame, and then act accordingly.

Your Switchvox administrator maintains a set of default time frames that you can use, or you can create, edit,
and delete your own time frames.

A time frame is considered valid when the current date and time match any one of a Time Frame’s rules. Not
all of the rules have to match.



Settings

Time Frames

Vaoicemail £ Fax

Create & New Time Frame

ll What are Time Frames for?

Time Frame Mame

Modify Your Time Frames

WeeaklyMeeting m

Yiew Default Time Frames

il What are default Time Frames?

During Business Hours

Cwtside Business Hours

Weaeskends Cnly

Creating a New Time Frame

Call History

| Create Hew

To create a new time frame, enter a unique name and click Create New. Enter any appropriate Start and End

Dates, Start and End Days, and Start and End times, then click Add.

Continue adding rules until you have completed the Time Frame definition.

The following are sample time frame definitions:

Start Date End Date Start Day End Day Start Time End Time
- - Monday Monday - -

- - Wednesday Wednesday - -
Mondays 12:01Am to 12:00Pm, and Wednesdays 12:01AM to 12:00Pm

Start Date End Date Start Day End Day Start Time End Time
- - - - 3:00 AM 6:00 AM

Early Morning




Start Date End Date Start Day End Day Start Time End Time

07/01/2009 07/07/2009 - - - -

The First Week in July 2009

Start Date End Date Start Day End Day Start Time End Time

01/21/2009 - - - - -

After January 21, 2009

Start Date End Date Start Day End Day Start Time End Time

02/01/2009 02/28/2009 Monday Friday 6:00 AM 7:00 AM

Weekdays in February, 2009 between 6:00 and 7:00 in the morning

Editing a Time Frame

To change a time frame, click its Edit button. This displays the Manage This Time Frame page. Create a new
rule, or multiple rules, and delete any rules that you do not want to include in this time frame. (You cannot edit

arule.)

Manage this Time Frame
ll How does this work?
Start Date End Date LStart Day End Day Start Time End Time

Maonday Friday :00 am 5:00 pr

N - ) BN - S E| Iy

Midrnight = 12:00 AM

Maon = 12:00 PM

Deleting a Time Frame

To delete a time frame, click its Delete button. Be sure that you do indeed want to delete this time frame, then
click Yes, Delete Time Frame. The Time Frames main page is deleted with a message that the time frame
was deleted.

Before you delete a Time Frame, be sure you do not have any IVR Menus or Call Rules that depend on it.



Phonebooks

Your Switchvox Phonebooks let you organize your contacts so that you can easily access them from your
Switchboard. Phonebooks can include your fellow Switchvox users, and external contacts.

Settings Voicemail £ Fax Call Histary

Phonebooks

Add Phonebook Entres ﬂ

Entry Type: | System Extenzion V|
Fhoneboolk:

Extension(s): | | 2
Fermission Type: 2 ® normal © Extended

Add to Phonebook

[:) Phone Provisioning Options ﬂ

Default New Phonebook

Your Default Phonebook [ 1to 12 ) of 12

# = Mave HMNurmber Mare Tupe Additional Murmbears
Ex
1 @ a0z Jane Doeson SIP Extension m
2 ge 103 1ohn Srmith SIP Extension | show |
3 & 104 Gilbert Brown SIP Extension E
5 @ 106 Spencer Flemming SIP Extension m
@ 109 Posey Podolsky SIP Extension m
3 & 10 Ortiz Schuster SIP Extension | show |
1z @ 113 Morris Madsen SIP Extension m
13 @ 114 Moon Bradley SIP Extension m
14 @ 119 windharm Stephens SIP Extension m
21 @ 611 Customer Service Call Queue m
22 @ 61z Technical Support Call Queue m
25 @ 899 Yoicernail Yoicernail m




Adding Phonebook Entries

There are different types of Phonebook entries, depending on whether the entry is known within Switchvox, or
is an external phone number.

System Extension Entries

System Extension Entries are other Switchvox extensions. You can add user-type extensions, and other
types of extensions such as queues or IVRs.

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Extension(s)

Enter at least one extension here. To enter multiple extensions, put a comma (,) after each extension. Click
the people icon to see a directory of your Switchvox extensions. Hold down Ctr to select many extensions, or
hold down Shift to select a block of extensions.

Permission Type
Normal: Shows the user’s Presence, and whether or not he or she is on the phone. Also includes a dropdown
that lets you open a chat, call additional numbers, or Intercom the person.

Extended: Shows the Normal features, plus the caller ID name and number of the user’s active calls. It also
includes options to monitor, record, whisper, barge into, or pick up the user’s calls.

Only phone-type extensions can be Extended Permission entries. If you try to add any other type of extension
(e.g., aCall Queue), it is added as a Normal entry.

You can change an entry’s permission type at any time.

If you cannot see or use an option in an Extended Entry, your Switchvox administrator has not given you
permission to do so.

External Number Entries

External Number Entries are for names and phone numbers other than Switchvox extensions. Once you add
an external entry, you will also be able to put Additional Numbers into that entry.

Make sure to enter external phone numbers as you would dial them from your phone. For example, if you must
dial 9 to get an external line, this entry must begin witha 9.

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Number
Enter the phone number.

Name
Enter a name.

Jabber ID
Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry.

The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example,
101@jabber.peeredswitchvox.com.



Status Indicator Entries

These entries are only available for Polycom and snom phones that Switchvox has configured in the Phone
Setup tool. If you don’t see this type of entry, check with your Switchvox administrator.

A Status Indicator entry controls a line status indicator light on your phone.

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

IMPORTANT: This must be the same Phonebook as the one in the Phone Features Options for this entry to
affect your phone. Also, it must be one of the first entries in the Phonebook if you want it to display without
having to scroll through the entries on your phone.

Entry Name
Enter a name for this entry. This isn’t required, as you don’t see the entry in your Switchboard.

Monitor Type
Parking Lot: This lights up the line status indicator on your phone when a caller is waiting in the specified
Parking Lot Extension.

Queue Login Status: This lights up the line status indicator on your phone when you are logged into the
specified queue. Enter the Agent Login Extension that you use to log into this queue, and the queue that you
want to monitor.

Switchvox-Peer Entries

If your Switchvox is peered with another Switchvox, you can include the peered Switchvox extensions in
your Phonebook.

For peered extensions, use the External Number entry type (because this extension is not on your
Switchvox).

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Number
Enter the extension number from the peered Switchvox, just as you would dial it on your phone. Peered
extensions might start with a different number than yours, or have more digits.

Name
Enter a name for this entry.

Jabber ID
Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry.

The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example,
101@jabber.peeredswitchvox.com.

Managing Phonebooks

To create a new Phonebook, click the New Phonebook tab. Enter a unique name for this Phonebook, and
click Create New Phonebook. This Phonebook is created and is now available in the Phonebook dropdown
when you create a new entry.

To move an entry back and forth as a Normal or Extended entry, drag the entry’s green arrow icon.



To delete an entry, click its Delete button. Be sure that you do indeed want to delete this entry, then click Yes,
Delete. The Phonebook is refreshed, and this entry is gone.

To delete a Phonebook, click its X icon. Be sure that you do indeed want to delete the Phonebook, then click
Yes, Delete.

Phone Features Options

The Phone Features Options let you specify a Phonebook to push out to your phone. Your phone must have
a Phone Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature Pack.

When you make changes to a Phonebook, or you want to change the Phonebook that is already on your
phone, click Reboot Phone to send the correct Phonebook out to your phone. Rebooting your phone takes a
few minutes, and you will not be able to make or receive calls while it is rebooting.

Note: If the phone is not on the same network as Switchvox, the phone might not be rebooted. In that case,
you must reboot the phone manually.

Select a Phonebook: | Default | BEETTEET S 12
Reboot Phone E'

Additional Numbers

Each Phonebook entry is based on one main extension or phone nhumber, but it can have also have additional
numbers associated with it. This way, you can have one Phonebook entry for a person, and have all of their
contact numbers included in that entry. The Additional Numbers are available via a dropdown (the blue plus
sign) in the Switchboard Phonebook entry.

To see and modify Additional Numbers for an entry, click the entry’s Show button.

2 @ 104 Gilbert Brown SIP Extension m

Additional Humbers: IE'
Mowe Icon Title Murnber Edit D[Delete Hide Ce

£ 4 F Mobie 5552223456 O

@ Add A Number

Additional Numbers can be entered by an extension owner, or you can enter them in your Phonebook entry.

Additional Numbers entered by an extension owner are available when you add the extension to your
Phonebook. These numbers appear as locked and cannot be edited, but you can choose to hide them in the
Switchboard.

Additional numbers that you add to your Phonebook entry can be edited and deleted. You can also copy any
Additional Numbers (including the owner's numbers), and then edit or delete the copy.



Additional Info

Your account and profile include Additional information that is used to help others in your organization find you
when you are away from your desk. For example, you can add your mobile phone number, your home phone
number, or even another extension that you use frequently. Numbers added here are shown in your co-
workers’ Phonebook entries.

Settings Voicemail £ Fax Call History

Additional Info

(2] additional Numbers

Mawve Icon  Title Muraber Edit Delete
£t [ mobile 912225551234 o R
ft O L s23 o X

@ Add A Number

To create a new number, click Add A Number. You can set anicon, title, and a phone number or extension.

The icon and title are displayed in your co-workers’ Phonebook entries. To change the icon for an entry, click
the icon.

IMPORTANT: Make sure to enter the number as you would dial it from your phone. For example, begin with a
9if that’s how you would normally dial that number.

Click the pencil icon to change a number, or the red X to delete a number. Drag the green arrows to change the
order that your numbers are shown in.

Conference Setup

This section lets you create your own conference room. Ask your Switchvox Administrator for the main
conference room extension number. When a caller dials that number, he or she can access your conference
room by dialing your conference room number.



Settings Voicemail £ Fax Call Histary

Conference Setup

B} General Settings
ﬂwhatis this for?

Your Conference Roorm Mumber: |:| i
5 digits

Play sound when people enter/leave

Sound type: | Sound with Caller Mame [uzer review option] | 2]

] Play Music On Hold when only 1 member is in the conference

Conference members may press # and be sent to extension |:| 2

¥l  Admin Settings

i"l'ell me more about admins

all available Accounts Conference Admins
103 Vlohn Smith" ~ 1M “Juztine Kilean"
104 "'Gilbert Brown' i 102 "Jane Dogszon
105 VAgrer Witk

106 "'Spencer Flemming'

107 "Mewtan Degenhardt'

108 "webster Savage” W
109 "Pozey Podolsky"

110 "Ortiz Schuster”

111 "Harvey Cubver"

112 "wiebb Sanderzon' hd

£

] Only allow conference admins to talk
] Hang up conference when all conference admins leave

[] Users can not talk until a conference admin is in the conference room

Save Conference Settings



General Settings

You can change the behavior of your conference room using several options.

Your Conference Room Number

Enter a unique 5-digit number for your conference room. This is the number that you give to callers so they can
access your conference room. Click the green arrow to have the system pick a random, unused room number
for you.

Play sound when people enter/leave

Check this box and select a sound to play to all members of the conference room when a new caller enters the
room. There are three options for the sound type that is played when a caller enters and exits your conference
room:

Only Sound: Only a sound is played, no information about the caller.

Sound with Caller Name: The caller is prompted to record his or her name. The recorded name is then played
along with a sound.

Sound with Caller Name (user review option): This is the same as Sound with Caller Name, but it gives the
caller an opportunity to listen to the recorded name, then accept or re-record it before joining the conference
room.

Play Music On Hold when only 1 member is in the conference room
Check the box if you want this to be true.

Conference members may press # and be sent to extension []
Enter an extension here, so that when member hit the # key, they are transferred to that extension.

Admin Settings

Admins are special members of a conference room who have additional privileges. Use the lists in this section
to identify which extensions are treated as admins of your conference room, and set the options for your
admins.

Only allow conference admins to talk
Check this box to make all non-admin callers listen-only.

Hang up conference when all conference admins leave
Check this box to ensure that your conference room is closed down after the conference is over.

Users cannot talk until a conference admin is in the conference room
Check this box to keep callers mute until an admin is in the room. Callers can join the room, but they cannot
speak to each other.

Phone Features

Use the Phone Features page to customize the way your phone works. Your phone must
have a Phone Feature Pack, otherwise these settings are not available. For details, see
Your Phone Feature Pack.

G,

IMPORTANT: If you make changes to any of these settings, you must reboot your phone
for the changes to take affect.



Phone Options

Phone Options let you set up the behavior of your phone. Your phone must have a Phone Feature Pack,
otherwise these settings are not available. For details, see Your Phone Feature Pack.

General Options
General options can be set for snom phones and Polycom phones.

Line Label
This is the set of letters and/or numbers that are shown on the line for your extension. By default, this is your
extension number.

Auto-answer Switchboard initiated calls

This sets your phone to automatically answer Switchboard-initiated calls. If you click on a Switchboard
phonebook entry, normally your phone rings and you have to pick it up, then Switchvox dials the number for
that entry. If this box is checked, your phone rings and then automatically goes to Intercom mode and
answers the Switchboard, and you hear the phone ringing for the call to your phonebook entry.

Hide missed calls

This turns off the missed calls notification. You can turn this back on but you will have to restart your phone,
so any calls you have missed in the meantime will be ignored, and you will not have a missed call notification
after the phone is restarted.

Polycom Options
Polycom Options are for Polycom phones only.

Line keys per registration

This sets the number of buttoned-lines on your phone that are set to this extension. For example, if you have a
3-line phone, you can set all 3 lines to your extension. That way, you can have an active call and 2 calls on
hold, and use the buttons to manage those calls.

Any line on the phone that is not used for your own extension will be automatically filled with your Phonebook
entries. For details, see Phone Features Options.

Do not show caller profile on phone during incoming/outgoing calls
This turns off the Switchvox Profile feature. For details on profiles, see Your Profile.

Distinctive Ringtones

Switchvox can store and play distinctive ringtones that can be used on your Polycom phone. Your phone must
have a Phone Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature
Pack.

Add a Ringtone

You can add as many ringtones to Switchvox as you want. However, each phone has two important lim-
itations for supporting ringtones that do not come standard on the phone:Maximum disk-use of 300 kilobytes
for all ringtonesMaximum of 8 ringtones



Add a Ringtone
Ringtone File (s filed: | |[ Browse..

Marne: | |

Add Ringtone

To add aringtone:
1. Click Browse, and find the file on your computer.
2. Inthe Name field, enter a name for this ringtone.
3. Click Add Ringtone.

The Distinctive Ringtones list is refreshed, with your new ringtone listed.

Distinctive Ringtones List

This list shows the ringtones that you have uploaded to Switchvox, and the ringtones that come with a
Polycom phone. (If you have added ringtones directly to your phone, those are not included in this list.)
Depending on the permissions you have on each ringtone, you can do the following:

*! Play the ringtone.
The audio file is downloaded to your computer, then played using your default audio player for WAV files.

¢ Edit the ringtone.
You can upload a new file, or change the Name.

X Delete the ringtone.
You must verify that you want the ringtone deleted. If you delete a ringtone, every Ring-Rule that uses that
ringtone is also deleted.

Distinctive Ring Rules

These rules control what happens when you get an incoming call on your Polycom phone. Your phone must
have a Phone Feature Pack, otherwise these settings are not available. For details, see Your Phone Feature
Pack.

Ring Rules define conditions for callers or kinds of calls, and then define what the phone does when those
calls come in. Here are the actions the phone can take if a call meets your conditions:

o Ring with the specified ringtone

o Auto-answer in Intercom mode

o Ring and auto-answer

o Mute the ring (your line still blinks)

To add a new Ring Rule:

1. Entera Rule Name E Distinctive Ring Rules IEI (only available for Polpoemm phores)

2. Select the action your phone add a Ring Rule:
should take (Ring Type). —
(Ring Type) Fule Mare: | | Using 8% of
Ring Type: | Standard Ring | [
0%
Ringtone: EEEE

Add Ring Rule



3. Select a Ringtone, if you have chosen a Ring action.
4. Click Add Ringtone Rule.
The new rule is created, with a link to Modify Rule Conditions.
5. Click Modify Rule Conditions.
The Rule Condition window is displayed.
6. Select a Call Type and set the Conditions

» Extension
If the incoming call is from any one of these extensions, the condition is met. This can be one or many
extensions.
Caller ID Number Range
If the incoming caller ID number is equal to one of these numbers, or it falls between them, the condition
is met.
Caller ID Number Pattern
If the incoming caller ID number matches this number pattern, the condition is met.
Use the asterisk (*) to indicate that "any number matches." For example, 619555* matches every call
with area code 619 and prefix 555.
Caller ID Name Pattern
If the incoming caller ID name matches this text pattern, the condition is met.
Use the asterisk (*) to indicate that "any letter matches." For example, *Smith matches every call from a
name that ends with Smith.
Ring Hint
If the incoming call has this Ring Hint associated with it, the condition is met.
Ring Hints are created and managed by your Switchvox administrator. They can indicate almost
anything, so check with your administrator before using this condition.
Queue Calls
If the incoming call comes from any queue, the condition is met.
Direct Calls
If the incoming call was made directly to your extension (or to a DID that is directly routed to your
extension), the condition is met.
* Internal Calls
If the incoming call originated in Switchvox, the condition is met.
» External Calls
If the incoming call originated outside of Switchvox, the condition is met.

When you have created the conditions that you want, click Close.
7. Restart the phone.

Once you have set up Ring Rules and restarted your phone, your ringtone disk space usage is displayed. This
is specific to your phone, and can help you decide which ringtones to use for your Ring Rules. You can add as
many ringtones to Switchvox as you want. However, each phone has two important limitations for supporting
ringtones that do not come standard on the phone:Maximum disk-use of 300 kilobytes for all
ringtonesMaximum of 8 ringtones

To change existing Ring Rules or Conditions:

o Edit
Click the Edit button to change the details of a rule, or of one condition in a rule.



© save
Click the Save button to save the changes that you made.

X Delete
Click the delete button to delete a Ring Rule, or to delete one condition in a rule.

Your Phone Feature Pack

If your phone does not have a Phone Feature Pack, please see your Switchvox administrator.

A Switchvox Phone Feature Pack offers the following features:

B,

L

o Customized phone displays
Customize some of the information displayed on your phone. See Phone Options.

o Status Indicators

Set a line status indicator light on your phone. This can show whether a call is waiting in
a parking lot, or whether you are logged into a queue. See Status Indicator Entries.

o Distinctive Ringtones

Set the audio file of your choice to ring on incoming calls, depending on the caller. See Distinctive Ring
Rules.

o Auto-answer

Set an automatic answer in Intercom mode, depending on your caller. See Distinctive Ring Rules.

o Combine Ringtones and Auto-answer

Combine a ringtone and auto-answer, depending on the caller. See Distinctive Ring Rules.

o Phone Applications

Access many of the Switchvox features right from your phone.
o)

The Phone Features available on your phone will vary, depending on the type of phone you have.

o The General Options are available on snom and Polycom phones.

o The other features are only available on Polycom phones. If you have a newer Polycom phone with
three or more lines (e.g., the VVX 1500 or SoundPoint 450, 550, 560,650, or 670) you should be able to
take full advantage of your Phone Feature Pack. Other Polycom phones may not offer all of the features.

Phone Applications

To use the Switchvox Applications on your Polycom phone:

1. Press the Applications key on your phone.
If your phone does not have that key, press the Services key.

2. If necessary, log into Applications by entering your password.
You will need to log into the Applications area if you have logged out, or if your phone has been logged into
a different extension.
Press the alpha/numeric soft key until it is set to numeric, then enter your password (the same numeric
password that you use to log into the Switchvox User Suite and your Voicemail). When your password is
correct, press the Right Arrow key to highlight Login, then press the Select key (this is probably a
Checkmark on your phone).



3. Select the Application that you want to use.
Press the Arrow keys to move up and down in the list of Applications, and press the Select key for the
Application that you want to use.

4. You can log out of Applications at any time. Use the Arrow keys to navigate to Log Out, then press
Select.

Note: Depending on your phone, navigating with the arrow keys might work differently. Also, when you first
press the Applications key on your phone, the display will show the last page that was available. For
example, you might see the profile of your last incoming caller.

The following Switchvox Applications are available:

Directory Access
Access the Switchvox Directory right from your phone.

Parking Lots
L perivo

View and pick up parked calls.

a] Phonebooks
Phonehaoks F\CCESS your Switchvox Phonebooks from your phone.

y Record Call
a1 Record your active call. (Call recordings are found in your Mailbox).

< Voicemail

View and listen to your Switchvox voicemail.

‘oicemail

A Log Out
L'uguu : Log out of these Switchvox Applications.

Within each Application, you can use your phone's soft keys.

Home | Exit Ref'r‘esh Back |

Home
Return to the list of applications.

Exit
Exit Switchvox Applications and return to the default screen for your phone.

Refresh
Refresh the information on the screen. For example, you might press Refresh in Parking Lots, to see if a call
was just parked.

Back
Go back to the previous screen that you used. For example, if you navigated through your Phonebooks to a
Phonebook entry, Back would return you to the list of Phonebook entries.



Voicemail /| Fax

This area lets you set up your voicemail and fax options, and manage incoming and outgoing voicemail and
faxes.

Mailbox

Your Mailbox lets you manage your voicemail and faxes in Switchvox.

Settings ¥Yoicemail f Fax Zall History

Mailbox

DOrganize your voicemail as easily as you organize your email, Put voicemails inkto folders, forw
and delete voicemails from the system,

view Folder: [IMNBO [ v m

ﬁ = k4 Eﬁglrilés[%] z‘ IE|.-'1‘-.g|r1er"u-'w-"itt (105] w
R ecordings [0]
. . wiork (0]

Woicemall in 1 Fax (1) o2 of 2

ﬁ . Drafts [2]

Original Dutbos (1] k) Date 2o

] 101 sentll] Iboeson <102 Thu Mar 19 2009, 10:10:16 AM
|:| 101 John Smith <103 Wed Mar 18 2009, 2:10:16 PM

You can access your Mailbox here in the User Suite, or from your desktop email application. See Putting the
Mailbox on Your Desktop for more information about using your desktop email application.

Voicemail

Your voicemail comes into the INBOX folder. Each message displays the original mailbox the message was
left in (the message might have been forwarded to you by a co-worker), the caller ID of the caller (if it was
available), the date and time the message was left, and the duration of the message.

To play or download a message, click its Play button. This marks the message as Read (it is no longer shown
as bold, and the message-waiting indicator light on your phone would go off if this was your only unread
message).

To delete messages, or mark them as read or unread, check the box for each message that you want to
affect. Then, click the appropriate icon (at the top of the list). If you delete messages, you are prompted to
verify the action. Be sure that you do indeed want to delete the messages, then click Yes, Delete.

To move messages to a different folder, check the box for each message that you want to move, select the
folder where the messages belong, then click Move To Folder.

To forward messages to another Switchvox user, check the box for each message that you want to forward,
select the extension to forward them to, then click Forward To.



To sort by column in the message list, click the column name.

Note: You can also manage your voicemail from your phone by dialing the voicemail access extension
(default is 899). Follow the prompts to give your password and check your messages. Or, your phone may
have a Messages button that dials the voicemail access extension for you.

Faxes

Your faxes come into the Fax folder. Your outgoing faxes are stored in the folders Drafts, Outbox, and Sent.
The Drafts folder includes the files that you have printed to your Switchvox fax printer. The Outbox folder
includes faxes that Switchvox is currently trying to send (or was unable to send). The Sent folder includes
faxes that Switchvox has successfully sent.

A fax license and the fax software must be installed to make faxing available. For details, ask your Switchvox
administrator.

To send a fax, check its box (you can only send one fax at a time) then click the fax machine icon (at the top of
the list). You are prompted to enter a fax number. Enter the number for the fax machine you want to send this
fax to, then click Send Fax.

IMPORTANT: When you enter the fax number, be sure to prefix any digits that you normally use to dial out.

Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been
successfully sent. If Switchvox cannot reach the other fax number to send your fax successfully, it remains in
the Outbox folder.

Note: Switchvox sends fax notification email messages. These notification messages show the status of
your fax. A Pending fax is still being sent (a fax may be Pending for a little while if Switchvox has to try
multiple times), a Sent fax has been sent successfully, and a Failed fax was never received by the fax
machine at the number you indicated. For details on setting up fax notifications, see Fax Options.

To preview page 1 of a fax, click Preview.

To view or download an entire fax, click Download. This marks the fax as Read (it is no longer shown as
bold).

To delete faxes, or mark them as read or unread, check the box for each fax that you want to affect. Then,
click the appropriate icon (at the top of the list). If you delete faxes, you are prompted to verify the action. Be
sure that you do indeed want to delete the faxes, then click Yes, Delete.

To move faxes to a different folder, check the box for each fax that you want to move, select the folder where
the faxes belong, then click Move To Folder.

To forward faxes to another Switchvox user, check the box for each fax that you want to forward, select the
extension to forward them to, then click Forward To.

To sort by column in the message list, click the column name.

For more information about faxing, see Creating & Sending a Fax.

Putting the Mailbox on Your Desktop

Your Switchvox Mailbox uses IMAP, a protocol that lets your desktop email application access remote
messages as if they were stored on your computer. In this case, it means that you can access your voicemail
and faxes in your Switchvox Mailbox using your regular email application (e.g., Microsoft Outlook or Mozilla
Thunderbird).



Your Switchvox Mailbox does not offer outgoing mail service, so if you want to forward a message or a fax,
you need to use your regular email account.

To set up your Switchvox IMAP Mailbox in your desktop email application, you’ll need the following
information:

o The IP address or domain name of your Switchvox mail server. This is the same |IP or name that you
use for the Switchvox User Suite.

o Your ‘email address,’ which in this case is your extension number, the @ sign, then your IP address
or domain name. For example: 101@192.168.0.100, or 101@pbx.mybusiness.com.

o Your ‘user name’, which in this case is your extension number.

o Your password, which is the same password that you use to log into the Switchvox User Suite and to
collect your voicemail.

IMPORTANT: If you are having trouble using your Switchvox IMAP account in your email application, check
with your Switchvox administrator. It’s possible that you need to use a different port number than the default
(143), or that you need to set specific security options.

In your email application, start the process to create a new Internet email account. When you are prompted to
enter the type of incoming mail server for the account, choose IMAP. Enter the rest of the information as
prompted.

Sample IMAP Setup

The following gives an example of creating an IMAP account in Microsoft Office Outlook 2007, running on the
operating system Windows XP Professional.

1. Open Microsoft Outlook, and select Tools > Account Settings.

The E-mail Accounts window is displayed.

Account Settings [E

E-miail Accounts
¥ou can add or remaove an accounk, Yoo can seleck an account and change iks settings.

E-mail | Data Files || R35 Feeds || SharePoint Lists || Internet Calendars || Published Calendars || Address Books |

1 Mew...

Marne Tvpe

Close

2. Click New to create a new e-mail account.

3. The Auto Account Setup window is displayed.



Add New E-mail Account

Auto Account Setup

Manually configure server settings or additional server bypes

< Back

[ Mext = ][ Cancel

4. Check the box for Manually configure server settings or additional server types.

5. Click Next.

The Choose E-mail Service window is displayed.




Add Mew E-mail Account

Choose E-mail Service

%) Internet E-mail
Conneck ba your POP, IMAR, ar HTTP server ko send and receive e-mail messages,

i) Microsoft Exchange
Conneck ba Microsoft Exchange For access ko wour e-mail, calendar, contacts, Faxes and vaice mail,

i) Other

Connect to a server bype shown below,

X

< Back. ” Mexk = ][ Cancel

6. Select Internet E-mail.
7. Click Next.

The Internet E-mail Settings window is displayed.




Add New E-mail Account

X)

Internet E-mail Settings
Each of these settings are required ko gek wour e-mail account warking,

User Information Test Account Settings

Your Mame: |:||_|5ti|-“3 Kilean | After filing out the information on this screen, we
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E-mail Address: |1|:|1@192. 163.0,100 | button below, (Requires network connection)

Server Information

[ Test Account Settings ...

Account Type: | IMAaP w |

Incoming mail server: | 192.168.0,100 |
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IUser Mame: |1|:,1 |
Passward: |***| |
Remember passwaord

[ ]Require logon using Secure Password Authentication (SPA) More Setkings ...

< Back ” Mext = ][ Cancel ]

8. Enter your name and your email address in the User Information section.

9. Select the Account Type IMAP, and enter the IP address or domain name of your Switchvox mail server
in the Server Information section.

10Enter your user name and password in the Logon Information section.

Check the box Remember password if you don’t want to have to enter your password each time you
access your email.

11Click Next.

You're finished adding this account.

Subscribing to Folders

When you have your Switchvox IMAP account set up in your desktop email application, you can manage the
same folders that are in the Switchvox User Suite Mailbox (Voicemail / Fax > Mailbox).

You can ‘subscribe’ to all of the folders, or just the ones you want to use. If you ‘unsubscribe’ to a folder, it still
exists in your IMAP account, it just isn’t shown in your email application. You can always subscribe to it again
later.

You can also create folders using your desktop application, and those folders are accessible in your User
Suite Mailbox.



To subscribe to your IMAP folders in Microsoft Outlook, highlight your Switchvox IMAP Inbox and select
Tools > IMAP Folders... The IMAP Folders window is displayed, shown here:

B [MAP Folders

Display folders whose names conkain;

| YT

Al Subscribed | stap
Folderz §
Fax (-\
Faw.Dirafts
Fax Outbox
Fax.Sent

o
inbos Fariy

[nbas. Friends
Inbow. FRecordings
[nbos ok,

whien displaying hierarchy in Outlook, show only subscribed Folders.

[ (0] 4 ] [ Zancel ] Apply

In Mozilla Thunderbird, highlight the account and select File > Subscribe. In either case, a list of folders is
displayed that lets you subscribe and unsubscribe.

Voicemail Options

Your Voicemail Options include setting up your voicemail greetings and defining how you want to receive
notifications of a new voicemail message.

Managing Greetings

Manage Voicemail Greetings lets you set up all of your greetings that might be played to a caller when you
don’t answer the phone. You can upload a sound file from your computer, or record a greeting using your
phone.

The default greeting, in every situation, is for Switchvox to read your extension digits and then let the caller
record a voicemail message. You can record or upload your name, and multiple custom messages for when
you don’'t answer the phone, or you are already on a call and don’'t answer the phone. If you don’t want to
distinguish between those situations, make sure you have created an Unavailable Voicemail greeting, then
check the box under the “Busy” voicemail greeting, Use Unavailable voicemail greeting.



Il Manage Yoicemail Greetings

Full name.
This recording is used in the company directory and by the default Unavailable and Busy greetings.
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Setting Notifications

Voicemail notification options let you customize how you want to receive a notification when you get a
voicemail message. You can set up multiple email addresses, each with an email template and instructions
for attaching the voicemail as a WAV file.



Note: Notification email messages do not synchronize with your Switchvox Mailbox. That means that if you
listen to a voicemail WAV file attached to a notification message, Switchvox does not know that you have
‘read’ the voicemail.

ﬂ Yoicemail Motification Options

EI Tell me more about this

Add Hew Hotification Email

# Ternplate Ernail Attach waw File Maodify/C
1 Default local copy Tes ml
2 External Justine@rmyhbiz.com e ml
D Delete local copy of woicemail, IEITEII me more about this

To add a new notification option, click Add New Notification Email. Enter your Email address, select a
template, and select Yes or No to indicate whether or not to attach the voicemail WAV file to the email
message.

To edit a notification option, click its Edit button.

To delete a notification option, click its Delete button. You cannot delete the local copy option (that is the
copy in your Switchvox IMAP mailbox), but you can change the template. This is the template that you will
see if you subscribe to your Switchvox IMAP mailbox using your desktop email application.

Delete local copy of voicemail

To delete the Switchvox copy of the voicemail once its sent to your email address(es), check the box Delete
local copy of voicemail. This option lets you handle your voicemail entirely through your own email account.

Managing Notification Templates

Voicemail Email Templates let you customize your voicemail notification email messages. You can create
multiple templates and tailor them to different types of email accounts. These custom templates are available
(along with default templates) when you create or edit a Voicemail Notification Option.



E Yoicemail Email Templates

El Tell me more about this
Create & New Yoicemail Email Template

Template Name: | | Create Hew

Yiew Default Yoicemail Email Templates

You can use variables in your template that are substituted with real values when the email gets sent. For
example, %VM_CALLERID% in a template prints as the caller's name and phone number. There is a full list
of these variables on the pages where you create or edit a template.
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% ¥M_DURYo - The duration of the voicermail message

%e¥M_MAILBOX% - The recipient's extension

% ¥M_CALLERID®o - The caller id of the person who left the message

% ¥M_DATE%o - The date and time the message was |eft

S DOWMNLOAD _LIMK® - &4 URL to the web admin to download the message

%eDOWNLOAD LIMK_AND_ MARK_DELETED®%@ - & URL to the web admin to download the message
recipient's mailbox,

$ave Template

Automatically Forwarding Voicemail

You can automatically forward all of this extension’s voicemail messages to other extensions in Switchvox.
This is helpful for generic extensions such as ‘Accounting,’ or ‘Shipping,’ or for queue extensions such as



‘Customer Service.” Callers can leave messages on one extension, then all of those messages are forwarded
to the appropriate people. This is also useful internally, if you want to send a message to everyone in a group.

To define a specific set of extensions to receive the forwarded voicemail, select Individual Extensions, and
move the appropriate extensions into the box on the right.

To specify an Extension Group to receive the forwarded voicemail, select Predefined Group, then choose an
Extension Group from the dropdown.

To delete each message from this extension’s Mailbox after the message is forwarded, check the box Delete
on Forward.

To send forwarded messages to all of the recipients, choose Send to All from the Forwarding Type
dropdown. To send forwarded messages to one recipient at a time, choose Round Robin. With Round Robin,
Switchvox forwards each message to the next recipient, moving through the list of recipients in the same
order as they are listed (in the extensions box above, or in the Extension Group).

ﬂ Yoicemail Forwarding
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Fax Options

Fax Options let you set up your faxing environment. You can enter multiple email addresses to receive
notifications of a new incoming fax, create a fax header, and define this extension as only sending faxes.



A fax license and the fax software must be installed to make faxing available. For details, ask your Switchvox
administrator.

Settings Yoicemail f Fax Call Histary

Fax Options
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[* show Advanced Options

Save Fax Options

Fax Notification Options

Add, Edit, or Delete the email addresses that you want to receive notifications of a new incoming fax.

This is useful if you want to be notified at both your work and personal email addresses, or if you want your
administrative assistant to be notified.

This extension only sends faxes

If this extension is really a fax machine and won’t make any voice calls, check the box This extension only
sends faxes.

Switchvox handles all outgoing activity as a fax:

o Print a fax-file
o Put it in the Fax. Outbox folder in that extensions’s Mailbox
o Send the fax



Fax Header

Enter a Fax Header to be sent with each fax that you send. For example:

Digium, Inc. | 877.546.8963 | Fax: 858.555.1212

This is the information that is printed along the very top of your fax pages (not to be confused with a cover
page).

Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an
Advanced Option, click Show Advanced Options.

Local Station ID
Text string that identifies the sender identification to the remote side of the fax transmission. Default is to
leave blank.

Disable Error Correction Mode (ECM) for G711 fax sessions
Disable error correction mode (ECM). The default is to leave this feature enabled.

Minimum transfer rate for fax transmissions
Minimum transfer rate used during fax rate negotiation. The default minimum transfer rate is 2400.

Maximum transfer rate for fax transmissions
Maximum transfer rate used during fax rate negotiation. The default maximum transfer rate is 14400.

Number of redundant signal packets for T38 fax sessions
T38 Error Correction Code (ECC) Signal Redundancy. This option specifies the number of redundant signal
packets contained in a T38 signal frame. The default value is 3.

Number of redundant image packets for T38 fax sessions
T38 Error Correction Code (ECC) Data Redundancy. This option specifies the number of redundant image
packets contained in a T38 image frame. The default value is 1.

Number of maximum expected T38 packet delay

Maximum expected T38 packet delay in milliseconds. The result of this specification is all T38 packets are
padded to prepare the fax stack for the specified delay. As long as the packet delay is less than or equal to the
specified value, the fax stack will not realize that there is an actual packet delay because of the packet
padding. The default value of 800 milliseconds should cover most use cases.

Creating & Sending a Fax

Sending a fax from your desktop computer using Switchvox is a two-step process:
1. Open afile in any application and print it to the Switchvox fax printer.
This stores a copy of the file in your Switchvox Mailbox Fax Drafts folder.

2. Go to the Switchvox User Suite Voicemail / Fax > Mailbox, select the Fax Drafts folder, and click the
fax machine icon (at the top of the list) to send that file to a fax machine. For details, see Faxes.

A fax license and the fax software must be installed to make faxing available. For details, ask your Switchvox
administrator.



Setting up a Fax Printer

To make faxes for Switchvox, you need to first set up a generic printer that you can use from any application.
You only have to do this once.

Depending on your desktop environment there are many ways to set up a printer, but there is some specific
information that you need to set up a Switchvox Fax Printer:

o For Windows-based operating systems, the URL is
http://YourDomain:631/printers/faxprinter

Where YourDomain is the domain that you normally use to go to your Switchvox User Suite. This may
be an IP address or a domain name.

o For Linux- or Macintosh-based operating systems, the URL is
http://ext:password@YourDomain:631/printers/faxprinter

Where ext is your extension, password is the password that you use to log into the Switchvox User
Suite or to collect your voicemail, and YourDoma 1n is the domain that you normally use to go to your
Switchvox User Suite. This may be an IP address or a domain name.

o For any operating system, use a generic postscript printer driver.

Our suggestion for Windows-based operating systems is the driver from
IBM: IBM Network Printer 17 PS. For Linux- and Macintosh-based operating systems you should choose
a generic postscript printer driver.

Sample Printer Setup

The following gives an example of setting up a Switchvox fax printer for a computer running a Windows XP
Professional operating system.

1. From the Start menu, go to Printers and Faxes.

The Printers and Faxes window is displayed.
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2. Click Add a Printer.
The Add Printer Wizard is displayed.



Add Printer Wizard

Welcome to the Add Printer
Wizard

Thiz wizard helpz you install a printer or make printer
connections,

through a JSE port [or any other hot pluggable
part, zuch az IEEE 1394, infrared, and zo o), pau
do not need to use this wizard. Click Cancel to
cloze the wizard, and then plug the printer's cable
inta your computer or point the prinker towand pour
computer's infrared port, and turn the prinker o,
Windows will autornatically inztall the printer for you.

J:}) |f you have a Plug and Play printer that connects

To continue, click Mest.

MHext » ][ Cancel

3. Click Next.

The Local or Network Printer windows is displayed.

Add Printer Wizard

Local or Hetwork Printer
The wizard needs to know which type of printer to zet up.

Select the option that describes the printer you want o uge:

() Local printer attached to this computer

{(¥) & network printer, or a printer attached to another computer

i To zet up a netwark, prinker that iz not attached to a print server,
‘\4) uze the "Local printer” aption.

< Back ” M et = l[ Cancel

4. Select A Network Printer...



5. Click Next.
The Specify a Printer window is displayed.

Add Printer Wizard

Specify a Printer
IF wou don't know the name or address of the printer, you can search for a printer
that meets pour needs.

Yw'hat printer do you want to connect to?

) Browsze for a printer

("3 Conrect to this printer [or to browse for a printer, select thiz option and click Mext);

M arne: | |

Example: Y\serverhprinter
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< Back ” M et = l[ Cancel

6. Select Connect to a printer on the Internet or on a home or office network, and enter the following URL:

http://YourDomain: 631 /printers/faxprinter

Where YourDomain is the domain that you normally use to go to your Switchvox User Suite. This may be
an IP address or a domain name.

7. Click Next.

The Configure Internet Port window is displayed.



Configure Internet Port

Security options

X

() ze anonymous account
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8. Select Use the specified user account, and enter your extension number and your password. This is the
same password that you use to log into the Switchvox User Suite or to collect your voicemail.

9. Click OK.

The manufacturer and model window is displayed.

Add Printer Wizard

‘-_F:'L Select the manufacturer and model of paur prinker. 1f paur prinker came with
an ingtallation dizk, click Have Digk. | pour pinter iz not lizted, congult pour
priniter documentation for a compatible printer.
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Hp S 1BM Network Printer 12 PS 3
IEM 5
infotec b 3&' IEM Metwork, Frinter 24 PS b

Esh This driver is digitally signed

Tell e why diver signing iz imporkant

OF. l[ Cancel ]




10Select IBM from the Manufacturer list on the left, then select IBM Network Printer 17 PS from the Printers
list on the right.

We suggest this printer driver because it is a widely available, standard printer driver. If you are using a dif-
ferent operating system, choose a generic postscript printer driver.

The Printer Wizard copies the appropriate files for you and sets up your new printer.
Wait until the Default Printer page is displayed, then go on.

11Select Yes or No, depending on whether you want this to be your default printer. (You probably want to
select No).

The final page of the Printer Wizard is displayed.
12Click Finish.

In the Printers and Faxes window, you can see the new printer
faxprinter on http:// YourDomain:631

Sending a Fax
Now that you have your fax printer set up, you can create a fax from any application.

1. Select the Print option from the application that you are using to view this document. (Or any open file that
is handy.) In the Print dialog box, select the new ‘faxprinter’ as the printer to use, and print the file.

2. In your Switchvox User Suite, go to Voicemail / Fax > Mailbox. Select Fax:Drafts from the View
Folder dropdown.

Your Fax.Drafts folder is opened, and your drafts are listed. The test page that you printed is in the list,
and you can preview the first page, or download a PDF of the entire fax.

Check the box for your fax, then click the fax machine icon (at the top of the list). You are prompted to
enter a fax number. Enter the number for the fax machine you want to send this fax to, then click Send
Fax.

Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been suc-
cessfully sent.

Settings Yoicemail f Fax Zall Histary

Mailbox

Organize your fax as easily as you organize your ermail, Put fares into folders, forward fax me
from the system.

view Folder: | Drafts [1) v|m
w & B % U [Farrn v Dl [agnenwitt (105) v

Zend Fax
Fax in Fax . Drafts fomer—TTto 1) of 1

IE Date Created & Source # Pages Preview

ivi  Wed Mar 18 2009, 2:14:29 PM Fax Printer 1 Q Preview



Call History

Under the Call History tab are two sections, Call Log and Call Reporting. These allow you to track your phone

use.

Call Log

The Call Log is a simple list of the calls that have been made to or by your extension. You can select a date
range by setting the From and To dates. Click View Report to see log in the User Suite, or click Output to
.Xls file to download an xls file.

By default, a list of all incoming and outgoing calls is displayed. The list includes the call date, who the call
was from and to, the type of call (incoming or outgoing), the call time, and the talk time. If you are viewing the
log in the User Suite, you can mouse over the Call Details to see more details about the call.

Settings

Call Log

Use this form to view the call history of this extension for a range of dates,

From Date: 03172008 | 7]

Voicemail £ Fax

Call History

To Date: |03 82008 | 7

rarnd ddf yyuy rrnd ddf gy

CallLlog {(1toa)ofa

Call Date o Zall Fram Call To Call Type  Call Time
03/18/09 3:28:19 PM Justine Kilean <101z Gilbert Brown <104 = autqoing 39s
03/18/09 32230 PM Jobhn Smith =103 = Justine Kilean <101 outgoing  4s
03/18/09 2:10:15 PM John Smith =103 = Justine Kilean <101 outgoing  53s
03/18/09 2:09:05 PM Jobhn Smith =103 = Justine Kilean <101 autgoing 1, Os
031809 2:08:00 PM Jobhn Smith =103 = Justine Kilean <101 outgoing  14s
03/18/09 1:18:25 PM Jane Doeson <102 = Justine Kilean <101 outgoing  10s

Call Reporting

This lets you generate a report about call activity. Call reports are generated for the date-range and criteria that

you specify, and include the information that you specify.



In the Report fields section you select one or more of the fields you would like included in the report or graph.
After you have chosen the desired fields you can choose how you want the report broken down. By default the
reports are broken down by date such that a data point is displayed for each day between the From and To
date.

You can instead opt to have the report broken down by the Hour of Day, the Day of Week or just one data
point for the whole range by selecting Total Cumulative. When you have finished specifying your criteria, you
can opt to have the report printed to the screen, sent to your desktop as an .xls file or view it in graphical form
in a chart.

Settings Voicemail £ Fax Call History

Call Reporting

Use this form to generate custom statistical reports about this extension's call history.,

From Date: 031772008 | 7] To Date: [03M8/2008 | 7]

rarny ddi vy rarny ddi vy

T atal Cumulative {5

Report Breakdown:

By Date
Report Fields: By Hour af Day

Tatal Humnber of Callz By Day of Week
Tatal Mumber of Incoming Calls
Tatal Mumber of Outgaing Calls
Tatal Talking Time

Tatal Call Duration

Average Talk Time per Call
Average Call Time per Call

Hold down CTRL to select rultiple iterns

Yiew Report Quput to .xls file Chart Report




The Switchboard

The Switchboard is a graphical display of what’s happening on Switchvox. It shows your own calls, your
coworkers’ calls, call-queue activity, and your parking lot. You can drag and drop to transfer calls, and one
click lets you make a call, pick up calls, record or monitor calls, log in and out of call queues, and more.

In addition to all of the Switchvox interaction, the Switchboard is also ‘Web Aware,” which means that you can
integrate other web applications with your call activity. Built-in panels bring SugarCRM, Salesforce, and
Google Maps to the Switchboard, and you can build custom panels that use the URL of your choice.

To open your Switchboard, click Launch Switchboard (in the upper right corer of your User Suite).

In the upper right of the Switchboard, you can see the number of voicemail messages that you have, new and
old. There is also an Options menu that lets you control your Switchboard.

Your Switchboard lets you have up to 6 active lines on your extension (in the Current Calls panel), regardless
of your phone’s capabilities.

About the Options Menu

The Options menu lets you control what is on your Switchboard, and how it is laid out. It also let you set your
status for your fellow Switchvox users.

Save Layout

Save Layout lets you save your Switchboard layout. The next time you open the Switchboard, the window is
the same size, and the same panels are open in the same place.

Panels

Panels let you open and close all of your Switchboard panels. Each of your Phonebooks is available as a
separate panel.

Your Switchvox administrator must give you permission to use many of the features available in the
Switchboard Panels. If you see a feature described here that is not available to you, please ask your
administrator.

My Presence

My Presence lets you set your Switchboard presence so that your co-workers can see your status and decide
how to communicate with you.

The Away and Extended Away options let you include a comment so that you can let people know when you
might be back.

Panels

The Switchboard panels let you see into the activity on Switchvox and manage your calls.



Current Calls Panel

The Current Calls panel displays all of the active calls on your extension, and gives you many options for
handling those calls. You can have as many as six current calls in the Switchboard, even if your handset does
not support that many.

Send Call
If you choose not to answer a call, click Send to send the call to your Call Rules. The default rule is to send
your calls to voicemail, so most likely Send means the caller is sent to your voicemail.

Hold & Resume
When you are on a call, one click puts that call on Hold, or Resumes the call.

Note: Resume is not available until you put the call on Hold.

Take Another Call
You can put your active call on Hold, and then answer another incoming call. You can have as many as six

current calls in the Switchboard, even if your handset does not support that many.

Transfer: Assisted & Blind

To transfer a call to someone in your Phonebook, just click the call and drag it from Current Calls to the
Phonebook entry. You can transfer a call at any time, even if you have the call on hold, or the other extension
is on an active call.

In an assisted transfer, you would put the caller on hold, call your co-worker to let him know you’d like to
transfer a caller, then complete the transfer. In a blind transfer, you would just drag the call to the Phonebook
entry.

Transfer to Voicemail
To transfer a call to your coworker's voicemail, just click the call and drag it from Current Calls to the
Phonebook entry’s envelope icon. This is handy if you know your co-worker isn’t able to take the call.

Record

When you are on a call, you can click to start and stop a recording of your call. The recording is sent to your
voicemail Mailbox, where you can save or forward it. Don’t forget, it’s up to you to let the other party know that
you're recording the call.
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Directory Panel

The Directory panel offers you access to all of the extensions in Switchvox. You can click and drag a call to
an entry in the Directory Panel to transfer the call to that extension.

Parking Lot Panel

The Parking Lot panel lets you ‘Park’ a call so that the call can be picked up at a different extension. To Park a
call, just click and drag the call to the Parking Lot panel. Then, you or any of your coworkers can pick up a

phone and dial the Parking Lot extension to be connected to the caller.

An extension must have permission to pick up a parked call.

Profile Panel

Customer Service
(6117

8dd Phoneboak Entry

The Profile Panel shows you the profile of the extension-owner you are talking to. Profile information can be
entered by the Switchvox administrator, or by the extension owner.



Justine Kilean

Account Manager

Extension: 101 2 5F &9
Laocation: San Diego

An Extension Profile includes some or all of the following:

° Image

o First and Last Name
o Title

o Location

o Extension Number

Profiles can be shown in the Switchboard and on a phone that uses a Phone Feature Pack. For details, see
Your Phone Feature Pack.

This panel also offers several one-click options to reach this person:

o Chat
Start a chat with this extension.

o Call

Call this extension. The Switchboard rings your phone, and then when you answer it rings this extension.
(You may be able to set up your phone so that it automatically answer calls from the Switchboard; see
Phone Options.)

o Voicemail

Call the voicemail for this extension. The Switchboard rings your phone, and then when you answer it
rings this extension's voicemail box so that you can leave a message. (You may be able to set up your
phone so that it automatically answer calls from the Switchboard; see Phone Options.)

Phonebook Panels

Each Phonebook panel displays the entries in that Phonebook. You can click on any entry to dial that number.
Some extensions can display as Extended Entries, to help you communicate more effectively with that
person.

Normal Entries

Normal Phonebook entries show your coworkers’ extensions or your frequently dialed external phone
numbers. Each extension is shown with its Presence information, and you can click on any of these to dial
them, like a speed dial button.

Also, Normal entries provide a ‘plus’ icon that includes options to dial that person’s Additional Numbers, chat
with him, or Intercom to him.

You must have permission to use Chat and Intercom. Chat may not be available if for some reason you can’t
chat with that person.



Extended Entries
Extended Phonebook entries have all of the normal extension options, but they also let you do the following
with that extension’s calls:

* Pick up an incoming call

» See who the caller is

* Record the call

* Monitor the call (the callers do not hear you)

* Barge into the call (both callers hear you)

* Whisper on the call (only your co-worker hears you)
You must have permission to use each of these options.

Presence
All Phonebook entries display the person’s Presence, which helps you and your coworkers be selective about

what calls to transfer to each other. An Away or Extended Away Presence can include comments.

Intercom
All Phonebook entries can include the Intercom option, which lets you talk to a coworker through the speaker
on his phone. With Intercom, your recipient doesn’t even need to pick up the handset to answer your call.

You must have permission to use this.

Pickup
Extended Phonebook entries can include the Pickup option (the green ‘up’ arrow). One click and your
coworker’s incoming call rings your extension also.

You must have permission to use this.

Record
Extended Phonebook entries can include the Record option. One click records the call, and sends the

recording to your voicemail Mailbox.
You must have permission to use this.

Monitor
Extended Phonebook entries can include the Monitor option. If you monitor a call, the callers cannot hear

you.
You must have permission to use this.

Barge
Extended Phonebook entries can include the Barge option. If you barge into a call, both of the callers can hear
you.

You must have permission to use this.

Whisper
Extended Phonebook entries can include the Whisper option. If you whisper into a call, the caller cannot hear
only (only the extension owner can hear you).

You must have permission to use this.
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Add Phonebook Entry

Chat Panel

The Chat panel lets you chat with your Switchvox co-workers. The main page of the Chat Panel offers a list of
people you can double-click to start a chat. Or, enter a Jabber ID and click Start Chat.

You must have permission to use this.

Queue Panels

Each Call Queue panel in your Switchboard contains views into that queue’s activity and statistics for the

day.

For queue members, you can log into or out of each queue with one click. Or, you can pause your status and
add a comment, letting your co-workers know why you’re unavailable and when you'll be back.

You must have permission to use this.
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CRM Panels

These time-saving panels integrate with your CRM application. When a call rings your phone, all of the
information for this customer is displayed immediately, before you even answer the phone!

You must have permission to use this.

Google Maps Panel

The Google Maps panel shows you where your caller is on a map based on area code and prefix. A popup
window lets you scroll through previous callers’ locations.

You must have permission to use this.

Custom Panels

Your Switchvox administrator may have set up custom panels that integrate with Web applications. Ask your
administrator for more information.

Popup URLs

Your Switchvox administrator can write external applications that set a display URL for each incoming call. If
this value is set, then the URL button lights up and clicking it opens a new window with the specified URL. If
you want that window to automatically open when a call comes in, click the green plus sign at the top-right of
the panel.



